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BEGINNING OUTLOOK

SENDING AND RECEIVING MAIL: (1-3 Introducing Outlook, 4-6 Outgoing Mail, 7-10 Incoming Mail)

USING CALENDAR: (1-4 Scheduling, 5-7 Configuring Calendar)

CONTACTS, TASKS AND NOTES: (1-4 Contacts, 5-7 Tasks, 8-9 Notes)

ORGANIZING AND PRINTING: (1-3 Categories, 4-7 Journals, 8-11 Printing)
BEGINNING OUTLOOK

SENDING AND RECEIVING MAIL

1 OF 10 (1-3 INTRODUCING OUTLOOK)

Outlook is an innovative and versatile desktop information manager that helps you to organize and share information on your desktop and to communicate with others.  It provides rich mailing, calendaring, scheduling, and collaboration features.  When you first start to use Outlook, you must select the type of configuration you want for Outlook.  There are three different configuration options available with Outlook that determine how the interface appears and how Outlook performs:

• Internet Only

• Corporate or Workgroup

• No E-mail

The Internet Only option allows you to use Outlook to connect to an Internet Service Provider (ISP) only via a modem.  The Corporate or Workgroup option allows you to use a mail service - such as Microsoft Exchange - and an ISP.  The No E-mail option allows you to use Outlook's organizational features but without access to the mail services.  Although you make the decision about which Outlook configuration you want during installation, you can change the Outlook configuration at any time.  To change the Outlook configuration, you select Options from the Tools menu.  In the Options dialog box you click the Reconfigure Mail Support button on the Mail delivery tabbed page.   The information services that you use with Outlook affect how

• you log on before using Outlook

• the user interface appears

• mail is addressed and delivered

• messages and folders are stored

The easiest way to start Outlook is to click the Microsoft Outlook icon on your desktop.  Clicking the Start button and selecting Programs - Outlook also launches Outlook.  On the Choose Profile dialog box, you can choose from a profile to use Outlook with.  A user profile is a group of settings that define how you are set up to work with Outlook.  You can configure Outlook to automatically bypass the Choose Profile dialog box and use a specific profile each time it is run.  You, or the network administrator, can configure the profile to specify the information service Outlook uses to send mail.  You can have one profile per computer, or - if more than one person has access to the computer - you can choose one from a list of profiles set up by the administrator.  But you can set a particular user profile to be the default so that Outlook always opens with that particular service.  Your logon procedure depends on the type of mail delivery software associated with your chosen information service.  For example, if you have installed the Corporate or Workgroup option, you must log on to your Windows 2000 network to connect to the Microsoft Exchange Server.  The Options dialog box differs depending on the type of configuration you choose for Outlook.  For example, the Mail Services tab is replaced by the Mail Delivery tab because you have only one service available - Internet Mail.  If you use Outlook within a corporate Exchange Server environment, for example, you will have access to the Global Address List containing the names and mail addresses of other users in the organization.  When connected over the Internet however, you would typically use addresses, which you have set up yourself, from the Contacts folder.
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Outlook contains the following Help features to help guide you through any of the areas of Outlook about which you are unsure:

• the Office Assistant

• Contents and Index

When you open Outlook, the Microsoft Outlook window is displayed and the Office Assistant appears.  It can provide help for whichever task you are performing in Outlook.  The Office Assistant provides this help in the form of tips, suggestions, and a search facility.  You close the Office Assistant by clicking Start using Microsoft Outlook.  You can choose to disable the Office Assistant by selecting the Hide the Office Assistant option from the Help menu.  You can access the standard help facility by selecting Microsoft Outlook Help from the Help menu.  You can choose to browse through the contents in the Contents tabbed page.  Or you can use the Index tabbed page to type keywords in search of the topic you want to explore.  The Answer Wizard tabbed page allows you to type a request for help using plain English.  For example, you can type in a message requesting help on Outlook Today and click Search.  And a range of topics is displayed answering your question.
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You can see an overview of the events of the day by clicking the Outlook Today button on the Outlook bar.  Outlook Today provides a daily overview of your tasks, appointments, and messages.   Using Outlook Today, you are able to check off tasks that you have completed.  Or you can click a task to open it and view it in more detail.  You can customize various elements of your Outlook Today interface by clicking Customize Outlook Today.  You can

• have Outlook start in Outlook Today

• choose the folders to display 

• set the number of days to be displayed   on the calendar

• organize the display of your tasks

• choose a style for Outlook Today

If you would like to save any changes you have made, you click the Save Changes button.  And you can see Outlook Today in a new style with new settings.  The Outlook Bar contains icons that provide you with shortcuts to various Outlook facilities.  For example, if you click the Contacts button, you open your Contacts Address Book.  You can click the My Shortcuts button to move to another group of shortcuts.  These shortcuts represent your personal folders.  You can use the Other Shortcuts section to navigate your computer and any networked drives that you are connected to.  You can choose to display all your Outlook folders on the Outlook interface.  To do this, you select Folder List from the View menu.  You can then use the folder list to navigate to the various Outlook items and facilities.

4 OF 10 (4-6 OUTGOING MAIL)

Outlook provides a full range of mail facilities that works not only with Microsoft Exchange Server, but also with most of today's widely used software.  You can create and customize mail messages in a variety of ways.  To create a new message, you select New - Mail Message from the File menu.  You can create a new message by clicking the New Mail Message button when you are in both Outlook Today and the Inbox folders.  And by clicking the New down-pointing arrow you can also create new messages and navigate to other Outlook folders and facilities.  You can create a new message based on one of a variety of existing mail templates provided by Outlook.  From the Actions menu you choose the New Mail Message Using option and select More Stationery.  You are now able to select a background for your mail message.  You use the Actions menu to set one of the following file formats for a message:

• Plain Text

• Microsoft Outlook Rich Text

• HTML 

You can also choose HTML if you choose Microsoft Word as your mail editor.  You can also change the file format in an open message using the Format menu.  You type the mail address in the To text box.   Or you can select a mail address for your principal recipient from your Address Book by clicking the To button.  In the Select Names dialog box you click the Show Names from the down-pointing arrow to specify the address list from which the name has to be selected.  In this case, however, you choose to select a name from the Global Address List.  You can type a name in the Type Name or Select from List text box.  Outlook automatically skips to the relevant alphabetical section of the list as you type a name in the text box.  And you click the To button.  You can enter as many recipients as you need to in the Message Recipients box when you need to send mail to multiple recipients.  You can send copies of the mail to other recipients by entering their names in the Cc box.  And you can hide recipients from the main recipient by entering their names in the Bcc box.  If you choose to send a blind copy to someone, the Bcc field is displayed in the main body of your message.  When you have selected the recipients of your message from your Address Book, you click OK.
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To enter the text of a message, you simply place your insertion point in the main body of the message and you start typing.  Once you have typed your message, you can customize it using the Formatting toolbar.  The editing options available to you depend on the file format and the text editor you use.  You can use the standard Edit menu commands with the Office clipboard to cut, copy, and paste text within various Outlook items.  The Clipboard, which holds a maximum of 12 items, appears when you have cut or copied more than 2 items.  To insert an item from the clipboard, you place the insertion point where you want it to appear and you click the relevant item on the Clipboard.  When you want to clear the Clipboard, you click the Clear Clipboard button.  You can add files to your mail messages.  You add attachments to your mail messages by selecting File from the Insert menu.  You can also use the Insert File button on the Standard toolbar.  Then you select the file you want to insert using the Insert File dialog box and click Insert.  Outlook allows you to add a formatted signature to your mail messages.  You insert your signature by selecting Signature from the Insert menu.  Then you choose the appropriate signature - in this case Aung Sun.  Before you send a message, you can

• configure the settings

• set the voting and   tracking options

• set the delivery options

• link the message to   chosen contacts

• set a category for the   message to allow you to   group it

You can track the progress of the message once you have sent it to find out when it is opened and when it is read.  To set the tracking options, you click the Options button.  In the Message Options dialog box you select the Request a delivery receipt for this message checkbox to have a message sent to you when it has been delivered to the recipients mailbox.  You select the Request a read receipt for this message checkbox to receive a message when the recipient has opened the mail message.  When you have set the message options, you click Close to return to the body of the message.  When your message is ready, you send it to the recipients by clicking the Send button.   You can recall a message if you do not want the recipients to see it.  To do this, you open the message from the Sent Items folder by double-clicking it.   Then you select the Actions menu.  You select Recall This Message from the Actions menu.  This option is available only with the Corporate or Workgroup configuration.  Since you want to delete copies of the message that haven't yet been read, you click OK.
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Let's say you want to send a message to Antonia Suares and a copy to Helen Campbell by using the Address Book.  You want to add the Current Strategy as an attachment, make sure you know when she gets it, and put your signature on it.  To do this, you click the New button.  You select File from the Insert menu.  Then you select the Current strategy document and click the Insert button.  You can also double-click the document.  You click the To button.  You select Antonia Suares and click the To button.  Then you select Helen Campbell, click Cc, and click OK.  You place your insertion point in the main body of the mail and type your message.  Then you select Insert - Signature - Anne Nicholls.  You click the Options button.  Then you check the Request a read receipt for this message checkbox and click Close.   And you click the Send button.

7 OF 10 (7-10 INCOMING MAIL)

When you receive mail messages in Outlook, they are placed into your Inbox folder.  You can create subfolders in your Inbox folder to which you can move messages that you want to sort.  And you can move messages between folders.  You can read the message and any attachments by double-clicking them.  You use the mail features for each open message to

•  forward the message   to another recipient

•  reply to the sender 

You can also navigate through the messages within your mail folder using an open message.  You can flag messages to remind you to follow them up later.  And you can arrange messages in ascending or descending order.   You can archive messages that you do not need in any of your folders but that you need to keep.  And you can find any messages you may have misplaced by searching for keywords in the subject and body of the message.
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When you receive a mail message, it appears by default in your Inbox folder.  You create new folders in your Inbox by selecting File - New - Folder.  You can also click the New down-pointing arrow and select Folder from the list.  You enter a name for your new folder in the Name field.  You can choose the type of item you want the folder to contain using the Folder contains drop-down list.  You select the folder in which you want the new folder to appear - in this case the Inbox - and click OK.  You click No to avoid placing a shortcut on your Outlook Bar.  You can open an attachment before you open a message by clicking the Open Attachment button on the Preview pane and selecting the attachment.  You can also save an unopened attachment by selecting Save Attachments from the File menu and selecting the attachment - in this case Hank Cartwright.  Then you click Save on the Save Attachment dialog box.  You can open a message by selecting it and choosing File - Open - Selected Items.  You can also open the message by double-clicking it.  To open the attached file, you double-click the icon.  And your Contact is opened.  If you want to forward the message to another recipient, you click the Forward button.  Then you select the new recipient address in the To text box and click Send.  If you want to return this message, including the new content, to the sender, you click the Reply button.  You type in your new message and click Send.  You can navigate a folder using an open message by using the Previous Item and the Next Item buttons on the toolbar.  By clicking the Previous Item down-pointing arrow you can select from a range of navigational markers to move around the folder.  For example, you would select the Item from Sender option to navigate to the previous mail item from the same sender.  You flag any messages that you need to pay particular attention to by clicking the Flag for Follow Up button.  Then you choose the type of action you need to take on the message.  You then choose when you need to carry out this action.  You click OK.  You can see that a flag heading has been added to the message.  And when you close the message, you can also see that the flag is displayed in the Inbox folder.  When you want to move items to another folder, you select the item and click the Move to Folder button on the toolbar.  You can also move items by dragging and dropping them between folders.  You select the folder to which you want to move the message - in this case Catalog.  And you can see the message has been moved.
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In the Outlook window you can sort your mail using the headings.  So, for example, to sort your messages by the date received, you would simply click the Received heading.  You turn on the AutoArchive feature by selecting Tools - Options.   Then you click the AutoArchive button on the Other tabbed page.  You ensure that the AutoArchive every checkbox is selected and you set the number of days using the spin box arrows.  You can select the Prompt before AutoArchive checkbox to receive notification before items are archived.  You can choose to delete expired items from the mail folders by selecting the Delete expired items when AutoArchiving (e-mail folders only) checkbox.  When you have set your archive options you click OK.  When you have enabled the AutoArchive feature, you can set archive properties for each individual folder by right-clicking it.  You can also archive folders by selecting Archive from the File menu.   You select Properties from the shortcut menu.  And you click the AutoArchive tab.  You then select the Clean out items older than checkbox and set your time limits.  Then you click OK.  To find items that you may have lost, you click the Find button.  This opens the Find pane and allows you to perform a quick search in the open folder.  To perform a thorough search, you click the Advanced Find button.  In the Advanced Find dialog box you can choose the type of item you want to find and the folder in which you want to search.  And you can further refine your search using these tabbed pages:

• Messages

• More Choices 

• Advanced
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Let's say you want to find a mail message that you received from Anita Cook, containing the text "Distribution", in the body of the message.  You want to move it to the Sales folder and set the archive options for that folder to remove items older than five weeks.  You click the Find button.  You click Advanced Find.  You type Distribution in the Search for the word(s) text box.  You select subject field and message body from the In drop-down list.  You click the Find Now button to begin the search.  You click the Close button.  You click the folder in which you found your message and select it.  Then you drag it to the Sales folder.  You right-click the Sales folder and select Properties from the shortcut menu.  You click the AutoArchive tab.  You click the spin box up-pointing arrow to change the number to 5.  You can also select the number and type 5.  You click the down-pointing arrow and select Weeks.  And you click OK.

END OF SENDING AND RECEIVING MAIL

SUMMARY: You have now seen Outlook's key mailing features.  Outlook is an innovative and versatile desktop information manager that helps you to organize and share information on your desktop and to communicate with others. The different configurations you choose mean a difference in the way Outlook appears. You can configure Outlook to have a number of different user profiles that define how you use Outlook.  You can use the Office Assistant to provide you with help with any of Outlook's features. Outlook Today provides you with a quick overview of your day and you can use it to alert you to pending tasks and appointments. The Outlooks Bar provides you with a simple means of navigating through Outlook folders and facilities.  Outlook provides a full range of mail facilities that work with most of today's commonly used software. Apart from using blank templates, you can create a mail message using a range of predesigned message templates. You can customize the font you use and the text blocks you create. You can use the Address Book to insert mail recipients or you can enter the names yourself.  Outlook allows you to attach documents to your mail messages that the recipient can open as you created them. You can track messages to ensure that you know that they arrived and you can recall messages that you don't want to arrive.  When you receive messages, they are normally available in your Inbox but you can create subfolders in your Inbox and move and organize your messages to best suit you. You can read messages and attachments by simply double-clicking them. And you can forward an open message to another recipient or reply to the original sender.  You can use open mail messages to navigate within a folder and you can arrange messages within a folder. Old or redundant messages can be removed from Outlook and stored in an archive file. And you can easily find files that you may have misplaced using the Outlook Find feature.

UNIT TEST:

1. Which of the following describes a user profile?

a. A group of settings that defines a user

b. A snapshot of the Outlook configuration after installation

c. A group of settings that defines how Outlook works

d. A description of Outlook that helps the user

2. A user is limited to one profile per computer.

a. True

b. False

3. Which of the following Outlook Today elements can be customized?

a. The folder display

b. The days displayed on the calendar

c. The mail display

d. The task display

4. Certain mail recipients can be hidden from others.

a. True

b. False

5. Which of the following can be configured on a message before it is sent?

a. The message settings

b. The voting and tracking options

c. The delivery options

d. The folder it is received in

6. By default, where are incoming mail messages placed?

a. In Outlook Today

b. In the Inbox

c. In the Personal Folder

d. In the Draft folder

7. You need to close a message in order to open the previous one in the folder.

a. True

b. False

ANSWERS:

1. c***(a)

2. False***

3. a, b & d***(c)

4. True

5. a, b & c

6. b

7. False

BEGINNING OUTLOOK

USING CALENDAR

1 OF 7 (1-4 SCHEDULING)

Outlook's Calendar allows you to manage meetings and appointments.  You can invite attendees to meetings, schedule all-day events, and mark recurring events, such as monthly meetings.  You can also add annual events such as birthdays, public holidays, and anniversaries to the Calendar.  An appointment is an activity in your calendar that does not require you to invite others or secure resources.   A meeting is an appointment to which you invite others.   And an event is an activity that lasts 24 hours or more.  To open Calendar, you click the Calendar button in the Outlook bar.  By default, the calendar is displayed with the current date on the banner above the calendar and the time in half-hourly segments.  On the right-hand side, the current and the following months are displayed, with the current date marked by a red square.  The TaskPad, which also appears on the right-hand side, displays your list of tasks.  Dates that are bold in the calendar are dates for which there are appointments and meetings scheduled.  To go to a specific date, you click it - in this case you view appointments on February 7.  You can view more than one day at a time by selecting a series of dates in the calendar on the right - in this case you choose to display four days at once.  You can view a whole week by clicking the pointer in the space to the left of the series of dates.  The four date buttons on the Standard toolbar allow you to select different views of the calendar.   You can go to a specific month by clicking the month label on the calendar and holding down the mouse button, an action that displays a list of months on either side of the current month.   You then select a month - in this case May 2000.  When you release the mouse button, that month is displayed.   You can click the left-pointing and right-pointing arrows to scroll month by month.  You create an appointment in the calendar by clicking the New button and selecting Appointment.   You can also create an appointment by selecting Actions - New Appointment.  You can make an appointment for a specific time by double-clicking the time slot on the calendar that corresponds with the appointment's starting time.  The appointment window has two tabs - the Appointment tab and the Attendee Availability tab.  The Appointment tabbed page allows you to specify the details of the appointment - such as the appointment's time and location.  And the Attendee Availability tabbed page allows you to invite attendees and to coordinate the time of the meeting.
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Let's say that you want to create an appointment for Monday, February 14.  To create an appointment, you click the New button down-pointing arrow and you select Appointment.  In the Appointment window you type the subject of the appointment - in this case Catalog update meeting - in the Subject text box on the Appointment tabbed page.  Then in the Location text box you type the location of the meeting - in this case you type Meeting room.  You click the Start time down-pointing arrow to specify a date for the appointment.  And then you select a date - in this case February 14.  You can see that the date for the end time reflects the same date as the start time.  You can select another day from the End time drop-down list to make the appointment a multiday event.  You specify a start time by clicking the Start time down-pointing arrow and selecting a time - in this case 9:00 AM.  And you click the End time down-pointing arrow and select an end time for the appointment - in this case you select 10:00 AM.  You select the Reminder checkbox to display a reminder for the appointment.  And then you choose the amount of time prior to the appointment that the reminder is to be displayed - in this case 10 minutes.  The Reminder Sound button allows you to choose a sound to play when the reminder is displayed.  And the Show time as drop-down list allows you to display to others the time for the appointment as being free, busy, tentative, or out of office.  You can write information and insert files or items - such as a task - in the body of the appointment.  If your appointment occurs regularly, you can make it a recurring appointment by clicking the Recurrence button.  In the Appointment Recurrence dialog box you specify the times for the appointment.  And you can specify the appointment's pattern - for example every Monday.  In the Range of recurrence section you specify a range for the series - in this case you choose to end the series on May 1.  Then you click OK to apply the series.
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Let's say that you want to create a new meeting to which you want to invite attendees.  To do this, you click the New down-pointing arrow and you select Meeting Request.  After adding the meeting title, location, and time details, you click the Attendee Availability tab to plan the meeting.  The tabbed page displays a list of attendees on the left-hand side and a schedule - with the time of the meeting - on the right-hand side.  You can view the status of each attendee - such as their role and response - by selecting the Show attendee status radio button.  To specify the people to attend the meeting, you click the Invite Others button.   In the Select Attendees and Resources dialog box, you can specify required attendees, optional attendees, and resources - such as a room or a projector.  You select a required attendee - in this case Mei Chang - and you click the Required button.  Once you have added all the attendees, you click OK to close the dialog box.  The attendees now appear in the All Attendees list and you can view a time grid that shows information about the attendees' availability.  For example, you can see that TonyC is busy during the time chosen for the meeting.  To let Outlook select the first available meeting time suitable for the attendees and resources, you click the AutoPick button.  You select the All People and Resources option to find a suitable time for everyone.  Outlook moves the meeting time slider to a new position - in this case 10.30am.  The left-pointing and right-pointing arrow buttons on either side of the AutoPick button let Outlook find the first available free time - prior to and after the current time - for all the attendees and resources.  You can click the Options button to change how time is displayed and to update attendees' free and busy information.  And you can click the Cancel Invitation button should you want to change the meeting into an appointment.  To send the meeting invitations, you click the Send button.  The messages are sent and you can see the scheduled meeting in the Calendar.  When you receive a meeting request, it is displayed in your Inbox.  You double-click the invitation to open it.  And you can see there are the Accept, Tentative, and Decline buttons for your response and the Calendar button to see the meeting in relation to other appointments.  You click the Accept button to accept the invitation to the meeting.  You then have the choice of editing your response, sending a response, and not sending a response.  In this case you choose to send the response and you click OK.  The messages accepting an invitation are displayed in the Inbox.  In the Calendar you double-click the meeting to open it.  And you can see that the information bar displays the attendees' response details.  You click the Attendee Availability tab to view the status of the attendees.  You can see their responses displayed in the Response column.
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You can add and remove attendees of a meeting by right-clicking the meeting in the Calendar and selecting Add or Remove Attendees.  This action opens the Select Attendees and Resources dialog box.  To delete an attendee, you select the attendee's name - in this case Mei Chang - and you press the Delete key.  To close the dialog box, you click OK.  Then you click the Send Update button to send an update to the attendees.  In the Send Update to Attendees dialog box, you can choose to send updates only to added or deleted attendees, or to all attendees.  In this case you choose to notify all attendees and you click OK.  And you return to Calendar.

5 OF 7 (5-7 CONFIGURING CALENDAR)

You can view your calendar in different ways.  For example, you can use the default view of one day.  Or you can view a week at a time.  You can view your calendar according to active appointments, such as holidays, meetings, and appointments.  You can also view your calendar according to scheduled annual events, such as birthdays and conferences.  A view can be customized to include your own choice of fields and settings.  And you can change the font and font style used to display your calendar.  To select a different view of the calendar, you select the View menu.  In the Current View submenu you see that the current view is the Day/Week/Month view.  There are four calendar type options related to this current view - Day, Work Week, Week, and Month.  You can associate the calendar with other Outlook items, such as e-mail messages and tasks.  For example, you can drag an appointment or meeting onto the Tasks button to create a task associated with the appointment.  In this case the task opens and you can see the details of the appointment displayed in the notes text box.
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Let's say that you want to apply a new view to your calendar so that you can see all your appointments.  To select a view of your calendar, you select View - Current View.  Then you select the view - in this case Active Appointments.  All your future appointments, meetings, and holidays are displayed.  The view divides the data into columns - or fields - including Subject, Location, Start, and End.  Recurring appointments are displayed as a calendar icon with two blue arrows, while individual appointments, meetings, and holidays are displayed as a calendar with a red square.  To customize the view, you select View - Current View.  And you select Customize Current View.  The View Summary dialog box opens and you can see that there are six buttons that allow you to choose different settings.  The customization options vary according to the view currently selected.  To specify, customize, and rearrange the fields that appear as columns in the view, you click the Fields button.  The Show Fields dialog box shows available fields and the currently selected fields.  To add a field - in this case the Duration field - you select it and you click Add.  The new field is added to the end of the list of current fields and to move it up the list, you click Move Up.  To remove a field, you first select it - in this case you select Categories.  Then you click the Remove button.  Once you have customized your view, you click OK.  You can see that a new description applies to the view's fields.  To choose how appointments are grouped, you click the Group By button.  You sort the entries by selecting an option from the Group items by drop-down list - in this case you select All Day Event.  You select the Show field in view checkbox so that the All Day Event field is displayed, making it easier to understand how the entries are grouped.  You ensure the Ascending radio button is selected so that entries are listed in ascending order and you click the OK button to apply the sort.  You click OK to create the view.  And you can see the new organization of the calendar.
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Let's say that you want to make your calendar available to others over an intranet.  To do this, you save your calendar as a web page.  To save a calendar as a web page, you select File - Save as Web Page.  In the Save as Web Page dialog box you select a starting date for the calendar - in this case February 1.  And then you select an end date for the calendar.  You ensure the Include appointment details checkbox is selected since you want to display any notes made.  In the Calendar title text box you type a title for the web page - in this case Aung Sun Dun's Calendar - February & March 2000.  And you click Browse to specify the location to which you want to save the file.  You type a name for the web page in the File name text box and then you click Select.  The file location is then displayed in the File name text box.  You ensure that the Open saved web page in browser checkbox is selected so that you can view your web page immediately.  You click Save to save the calendar as a web page.  Saving a calendar as a web page is a feature that may not currently be installed, so you may need to install it from the Microsoft Office 2000 CD.  You are informed that the file is being saved.  And the page is displayed in your browser.  You click an appointment to have it displayed in the right-hand frame.

END OF USING CALENDAR

SUMMARY: You have seen how to use Outlook's Calendar.  Outlook's Calendar allows you to manage meetings and appointments. You can invite attendees to meetings, schedule all-day events, and mark recurring events, such as monthly meetings. You can also add annual events such as birthdays, public holidays, and anniversaries.  An appointment is an activity in your calendar that does not require you to invite others or secure resources. A meeting is an appointment to which you invite others. And an event is an activity that lasts 24 hours or more.  There are several different views of the calendar - day/week/month, active appointments, events, and recurring appointments. In the day/week/month view, you can view your calendar in different ways - by day, work week, or month.  You can save your calendar as a web page, specifying the start and finish dates as well as a graphic for the background.  You can integrate Outlook's Calendar with other Outlook items, such as e-mail messages and tasks. For example, you can drag an appointment or meeting onto the Tasks button to create a task associated with the appointment.

UNIT TEST:

1. Which of the following options correctly describes why a date is displayed in bold in the calendar?

a. It indicates an appointment related to a task

b. It indicates an appointment to which you are invited as an attendee

c. It indicates a date on which an appointment occurs

d. It indicates today's date

2. While _____ is an activity that does not require you to invite another person, _____ is an activity to which you invite others.

a. a meeting

b. an appointment

3. An event is an activity that lasts 24 hours or more.

a. True

b. False

4. When customizing Calendar, you can change the _____ style used.

a. paragraph

b. font

c. numbering

d. border

5. When you save a calendar as a web page, you can display only one month at a time.

a. True

b. False

ANSWERS:

1. c

2. 1st blank: an appointment, 2nd blank: a meeting

3. True

4. b

5. False

BEGINNING OUTLOOK

CONTACTS, TASKS AND NOTES

1 OF 9 (1-4 CONTACTS)

Your contacts are the people or organizations you communicate with in your personal and business environments.  The Contacts folder enables you to keep up-to-date information about your contacts in one location.  The information in the Contacts folder is accessible to all Office applications.  You can include the following categories of information about your contacts:

• General

• Details

• Activities

• Certificates 

• All Fields

You open the Contacts folder by clicking the Contacts button on the Outlook Bar.  In the Contacts view you can add contacts, edit contact information, and delete contacts from your list.  You can send contact information via a mail message from the Contacts view.  You can also sort Contact information by fields.  You can display information about your Contacts in various ways using the Current View option on the View menu.  The current view in this case is the Address Cards view.  You can change the view to, for example, the Phone List view, depending on the information you want to display.  You can customize any view by selecting the Customize Current View option.  You can then click one of the buttons in the View summary dialog box and customize the properties of the view.  You create a new contact by selecting the File menu and choosing New - Contact.  You can also click the down-pointing arrow on the New button and select Contact.  Or you can click the New button without selecting the down-pointing arrow.  A new contact information sheet opens and you fill in all the necessary information for your contact and you click Save and Close to create the new contact.
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If you want to edit the information for a contact, you can double-click the particular detail you want to edit, in this case Helen Campbell's mobile telephone number.  Or you can edit the information by double-clicking anywhere on the contact.  The contact information sheet then appears so that you can update the information about the contact you have selected.  You can rearrange the display of phone numbers in the Contacts pane by changing their order.  For example, if you want to display Helen's mobile number first, you click the down-pointing arrow and select Mobile from the list.  And you can rearrange the other numbers in the same way.  You need to save any changes you have made to your contact's information by clicking the Save and Close button.  You can use the Letter tab to find Contacts.  You click the first letter of the Contact you want to find in order to go to that Contact.  And the Contacts beginning with the selected letter are displayed.  You can delete a contact you no longer use by selecting it and clicking the Delete button.  You can also press the Delete key on your keyboard.  And the contact no longer appears in the Contacts view.
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To send a Contact via a message, you first select the Contact you want to send and then you select the Actions menu.  You select Forward from the menu options.  Your contact information is now ready to be forwarded in a mail message as an attachment.  When you have addressed the mail message, you click Send to forward the contact information.  You can send a mail message to a contact by selecting the contact and clicking the New Message to Contact button on the toolbar.  This creates a mail message addressed to the selected contact.   You can sort your contacts by a particular field by choosing Current View from the View menu.  Then you select Customize Current View from the list of options.  And you click the Sort button.  You can sort the contacts by any one of the fields from the Sort items by drop-down list.  You can choose to sort your contacts in ascending or descending order using the File As field.  And you can further sort your contacts by choosing a field from the Then by drop-down list.
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Let's say you want to create a contact record for a recent business acquaintance.  To do this, you click the New button.  On the contact information sheet you can type the contact's name directly into the Full Name text box but in this case you click the Full Name button.  You select Mrs. from the Title drop-down list.  When you have filled in the fields in the rest of the Check Full Name dialog box, you click OK.  You change the first number on the phone number list by clicking the down-pointing arrow and selecting Company.  Then you enter all the relevant phone numbers.  You select the type of address you want to enter - in this case Home - using the Address drop-down list.  Then you click the Address button.  When you have entered the address details, you click OK.  You type the mail address into the E-mail text box.  Then you click the Details tab.  When you have entered all the details for your new Contact, you click Save and Close.

5 OF 9 (5-7 TASKS)

You can use Outlook's Task folder to track your duties or errands until you have completed them.  You open the Task folder by clicking the Task button in the Outlook Bar.  The Tasks pane is then displayed.  You create a new task by selecting New from the File menu and choosing Task from the list of options.  You can also create a new task by clicking the New down-pointing arrow and selecting Task from the list.  You can create a simple task by typing one into the task at the top of the Tasks pane.  Or you can simply click the New button.  On the Task tabbed page you can set tracking details such as Due date and Start date.  And you can set the status of the task by choosing an option from the Status drop-down list.  You can set the priority level for the task and, as time passes, the percentage of the task that has been completed.  The Reminder is enabled automatically if you select a due date.  You can change the reminder date on the drop-down calendar.  And you can change the time of day that you want the reminder to prompt you.  You can give a title to a task by typing one into the Subject text box.  And you can make notes or comments on the task in the Comments window.  You open the Categories dialog box by clicking Categories and use it to find or group related items by assigning the task one or more categories.  And you can hide this task from anyone who has access to the shared folder by selecting the Private checkbox.  You can enter information about the completed task on the Details tabbed page.  You can include information about the length of time the task has taken, mileage used, and the billing details.  When you have created a task, you need to save it by clicking Save and Close.
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To update a task, you double-click it to open it.   You can then edit and update the task as required.  You can assign tasks to other people using the Assign Task button.  Outlook automatically tracks the status of the task and sends updates to the person who assigned the task.  To send a task to an assignee, you enter the mail address in the To text box and click the Send button.  When you receive an assigned task you can accept or reject it.  If you accept the task by clicking the Accept button, you become the task owner and the sender has no access to the task details.  If you reject the task, the sender can then reassign it to someone else.  You can follow the progress of an assigned task by opening it and checking the percentage complete figure.  You can easily create a task from another Outlook component by dragging it to the Task button on the Outlook Bar.  A new task is then created using the details of the original Outlook item - in this case a note.  You can change the view for the tasks by changing the criteria by which the tasks are displayed.  Selecting View - Current View displays the list of views that you can use to display your tasks.  You can change the view by selecting a new view from the drop-down list.  You can now see the view displayed By Person Responsible.
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Suppose you want to create a new task based on a request you have received in a mail message.  You want to assign the task to Bel Peach, set a due date for it, and keep an updated copy in your task list.  You also want to have a status report sent to you when the task has been completed.  You drag the message about the party list from the Inbox folder to your Task button on the Outlook Bar.  And in the Task folder you click the Assign Task button.  You click the To button.  You select Bel Peach from the list and click the To button.  Then you click OK.  You click the Due date down-pointing arrow to open the calendar and select 28.  You click the Send button.  And you are returned to the Outlook window.

8 OF 9 (8-9 NOTES)

Outlook allows you to create electronic notes that you can use to jot down ideas, questions, or phone numbers that you may later use in an application.  You open the Notes folder by clicking the Notes button in the Outlook Bar.  You can create a new note by selecting New from the File menu and choosing Note from the menu options.  You can also click the New down-pointing arrow and select Note.  Or you can simply click the New button.  On the open note you type the note text.   You click the Close button to save the contents of the note and place it in the Notes pane.  You can open and edit a note by double-clicking it.  Once open, you can change the contents of the note.  And you can resize a note by dragging its edges to the desired size.  You can access any of your open notes from the task bar.  You click the note button on the task bar that you want to open.  And your note is displayed for editing.  You can choose to display your notes as 

• large icons

• small icons

• a detailed list

You can customize the look of a note by clicking the Note icon in the top left-hand corner of the note.  From the menu list, you can choose to display your note in a different color to the default yellow.   The note is then displayed in the new color.  In order to place your note into a category, you click the Note icon.  Then you select Categories from the list of options.  You select categories that you want to assign to the item from the Available categories list - in this case Business and Competition - and you click OK.  You can change how you view and organize your notes by selecting Current View from the View menu.  You can then choose a display option for your note.   You can, for example, choose to display your notes By Category.
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Let's say you want to create a note to record a phone number.  You also want to edit the note by placing it in the Hot Contacts category and change the color to green.  You click the New button.  Type the number and name you want in the note - in this case 554 7685 - Philip.  And you click the Note icon.   You select Categories.  You select Hot Contacts and click OK.  Then you click the Note icon.  You select Color - Green.  And you can see that your note is green.

END OF CONTACTS, TASKS AND NOTES

SUMMARY: You have now seen how to use contacts, tasks, and notes in Outlook.  The Outlook Contacts facility enables you to keep all your up-to-date contacts in one location. You can include various categories of information about your contacts that include names, addresses, web pages, and telephone numbers. You can display your contacts in several views based on fields,  such as Name or Subject, in the Contacts view.  You can use Outlook's Task folder to track duties or errands until they have been completed. You can also assign tasks to other individuals and follow their progress throughout the completion of the task. When you send a task to another individual, the recipient can either accept it or decline it. By accepting the task, the individual becomes the owner of the task and the sender can no longer change the task details. If the recipient of the task rejects it, the sender can forward it to another recipient. You can arrange and display your tasks based on a number of different criteria.  Outlook provides an electronic note facility that you can use to jot down ideas, questions, or trivia that you can later enter into a relevant application. You can organize your notes by color coding them or you can change the view. You can create categories for your notes that will help you to organize and display them.

UNIT TEST:

1. Which of the following can you use your Contacts folder for?

a. To publish information on a web site

b. To save a contact's business address and telephone numbers

c. To assign activities that you need to carry out for the contact

d. To make appointments with contacts

2. Which of the following are true of the Contacts facility?

a. It can be used to send mail

b. It cannot be used by other applications

c. Contact information can be sent via a mail message

d. Information can be displayed in a variety of ways

3. Which of the following are true of tasks?

a. A task can be tracked from beginning to end

b. You cannot refuse to accept a task

c. You can assign tasks to other people

d. Senders of assigned tasks can change task details once the receiver has accepted it

4. You can create a task from any other Outlook component.

a. True

b. False

5. In which of the following ways can a note be viewed in the Note pane?

a. As a large icon

b. As a detailed list

c. As a preview of the note

d. As a small icon

6. Do you think you can save a note as a file on your computer?

a. Yes

b. No

7. Which of the following can be used to organize notes?

a. Applying a category to the note

b. Saving the note as a file

c. Viewing the note in a detailed list

d. Changing the color of the note

ANSWERS:

1. b, c & d

2. a, c & d

3. a & c***(d)

4. True

5. a, b & d***(bc)

6. Yes

7. a & d***(b)

BEGINNING OUTLOOK

ORGANIZING AND PRINTING

1 OF 11 (1-3 CATEGORIES)

Categories are keywords or phrases, for example Business, by which you can relate separate items in Outlook to one another.  This makes it easier to find, sort, or group items that are stored in Outlook views.  The Master Category List is made up of the different categories available for grouping items.  You are able to add your own categories to this list or delete items from it.  To open the Master Category List, you first select the Edit menu in any Outlook view.  Then you select Categories.  The Categories option is available only when there are items in the current Outlook view.For example, if there are no entries in the Contacts folder, the Categories option is inactive in the Contacts view.  And in the Categories dialog box you click the Master Category List button.  In the Master Category List dialog box you can add categories of your own to the list or you can delete items from the list.  To add a category to the master list, you type the name of the new category, in this case Catalog, in the New category text box and click Add.  The new category appears in the categories list box and you click OK.  When you add a category to the master list, the category automatically appears in the Available categories list in the Categories dialog box.  You can add a category to the Master Category List by adding it to the Categories dialog box.  To do this, you type the new category name, in this case Nepal conference, in the Item(s) belong to these categories text box and you click Add to List.  The category then appears in the Available categories list.  When you look at the Master Category List, the new category appears in the list box.  If you want to delete the category from the Master Category List, you select Nepal conference and you click Delete.  Then you click OK.  When a custom category is deleted from the Master Category List, it is not automatically deleted from the current view Available categories list.  But if you do not assign the category to an item in that view, the category will be deleted when you close the Categories dialog box and will not appear the next time you open the categories.  If you want to reset the Master Category List to the default settings provided with Outlook, you click the Reset button in the Master Category List dialog box.  Then you click OK to confirm you want to reset the categories.  The custom categories are reset and you click OK.  The Available categories in the current view do not change when you reset the Master Category List because the categories remain there as long as they are assigned to items in that view.
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You can assign items to a category in any view by selecting the item and defining a category for it.  Or you can assign a category to an item when you create the item.  The method for creating categories in new items is the same in all Outlook views but the first step differs from one view to another.  To view the category list in

• a message, you select  View - Options

• an appointment, you   click the Categories   button on the Appointment   tabbed page while creating   the item

• a task, you click the   Categories button on the  Task tabbed page while   creating the item

• a contact, you click the   Categories button on the  General tabbed page while   creating the item

• a note, you right-click a   note and select Categories

Suppose that you want to define a category for a new contact when you create it.  To do this, you click the Categories button on the General tabbed page.  You can also right-click the contact in the Contacts view and select Categories.  In the Categories dialog box you select a category checkbox, for example Key Customer, from the Available categories list box and you click OK.  The new category is displayed in the text box next to the Categories button and all the items in the category can be viewed in the Contacts view.  Let's say you want to assign a category to an item that has already been created in the Contacts view.  To do this, you first select a contact, for example Helen Campbell.  To assign a category to the selected item, you select Edit - Categories.  You can also right-click the item and select Categories from the shortcut menu.  Then you select a checkbox in the Categories dialog box, in this case Business, and you click OK.  The categories that you select for your contacts are not visible until you organize the Contacts folder according to the categories listed in it.  To organize the Contacts view, you select the View menu.  And you select Current View - By Category.  The Contacts view now displays the categories that have been assigned to various contacts, in this case the Business, International, and Key Customer categories.  When you click the + icon next to a category name, for example Business, the category field expands and you can view all the contacts that have been assigned to the category.  You can arrange the contacts within a category according to the fields, for example the File As field.  You can also assign more than one category to a single item so that it appears in more than one category group in the current view.
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You can use categories to sort information in Outlook.  For example, you may want to use categories to sort the information in your calendar or in Tasks view.  To sort information in your calendar, you select View - Current View - By Category.  The categories are displayed and you can expand them by clicking the + icons next to the category names.  To sort the items in the Tasks view, you first click the Tasks button to switch to the Tasks view.  Then you select View - Current View - By Category.  The Tasks are grouped by the categories assigned to them and you can expand the category lists by clicking the + icons next to the category names.  Within the category lists you can still order tasks according to the fields that appear in the Tasks view.  For example, you can click the Status field header to see which tasks are completed and which are not.  

4 OF 11 (4-7 JOURNALS)  

Outlook's journal is an electronic log book of all your activities.  You can use it to track computer-related activities, such as e-mail messages, and noncomputer related activities, such as conversations.  It is intended largely for events that are happening or have happened already, as opposed to the other Outlook components, which are geared towards the future.  The journal consists of entries and each entry has at least a subject, an entry type, a date, and a starting time.  You can also link the entry to a contact and make it part of a category.  If you want the entry to be for your eyes only, you can select the Private checkbox.  The Journal Entry window has ample space for you to take notes on the entry.  You can also insert other objects, such as Word documents or images that are relative to the entry, in this space.  When you insert an object, you can insert it as a copy of the object or as a link to the original object, which you can edit directly in the journal entry.  And you can choose to display the object or you can display it as an icon.  To create a journal entry, you can enter all the details in the Journal Entry window.  Or you can configure Outlook to automatically create entries for certain items.  Outlook can automatically create journal entries for the following Outlook events:

• e-mail messages

• meeting requests

• meeting cancellations

• task requests

• task responses

You need to specify the contacts for whom these events are to be tracked.  When you work with other Office applications, you can configure Outlook to record the time you spend on these in your journal.  You can record the time spent on the following applications:

• Access

• Binder

• Excel

• PowerPoint

• Word

You can set the view in your journal to display the entries for

• one day

• one week

• one month

Once you have created entries, you can open them and modify any of their details.  If you change the date or start time of an entry, you are in fact moving the entry.  You can also delete entries that have been created.
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Suppose you are discussing adopting the strategy of distributing products by rail transport as an alternative to distribution by road transport with Hank Cartwright, the distribution manager.  In order not to forget the ideas that are being exchanged, you want to record the conversation in your Outlook journal.  You start by clicking My Shortcuts on the Outlook bar.  Then you click the Journal button and Outlook displays your journal entries if there are any.  To manually create a new journal entry, you click the New button.  You can also create a new journal entry by selecting File - New - Journal Entry.  Outlook then opens the Journal Entry window and it enters the default entry type, date, and start time.  You type a subject for the entry in the Subject text box.  And you select Conversation from the Entry type drop-down list.  To cause Outlook to automatically calculate the duration of the conversation, you click the Start Timer button.  To enter Hank's name in the Contacts text box, you click the Contacts button.  And in the Select Contacts dialog box you select Hank's name and you click OK.  You can type his name in the text box but if you make a mistake, the entry will not be linked to the correct contact.  To categorize the journal entry, you click the Categories button.  In the Categories dialog box you select the Strategies checkbox and you click OK.  When you return to the Journal Entry window, you record the main ideas of the conversation.  And when the conversation is finished, you click the Pause Timer button.  To save your changes and close the Journal Entry window, you click the Save and Close button.  Outlook lists your new entry in the journal.
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Suppose that you want to configure Outlook to automatically create entries in your journal when you work in Office applications.  You start by selecting the Tools menu.  And you select Options.  On the Preferences tabbed page of the Options dialog box you click the Journal Options button.  To configure Outlook to automatically create a journal entry when you work on Access databases, you select the Microsoft Access checkbox.  And you do the same for all the other Office applications and you click OK.  You return to the Options dialog box and you click OK.  Now when you work in an Office application, Outlook will create a journal entry to record the time you spend working in the application.  The author of the document will be placed in the Contacts text box.  7 OF 11  Suppose that you want to change a journal entry that was made previously.  You set the timer too early so you want to change the starting time and you want to add a link to a spreadsheet to your notes.  You also want to delete an existing journal entry.  You start by selecting the entry that you want to modify.  Then you select File - Open - Selected Items.  If there is more than one entry listed under the entry type that you selected, Outlook opens all of the items with the last item opened in the active window.  In the Journal Entry window you select the time that is incorrect.  And you type the correct starting time.  You can select a time from the drop-down list but then you are restricted to predefined options at half-hourly intervals.  To create a link to a spreadsheet, you position the insertion point in the text where you want the link and you select Insert - Object.  Outlook then opens the Insert Object dialog box.  Because the file already exists, you select the Create from File radio button and you click the Browse button to locate the file.  In the Browse dialog box you locate the file, select it, and you click OK.  When you return to the Insert Object dialog box, you select the Link checkbox.  And you select the Display As Icon checkbox.  Then you click OK.  You click the Save and Close button to complete your changes.  Outlook returns you to the journal.  Suppose you want to delete the last entry type in the list so you select it.  And you click the Delete button.  You can also press the Delete key or you can right-click the selected entry type and select Delete.  You click OK to verify that all the selected items in the group must be deleted.  Outlook removes the entry type from the list.

8 OF 11 (8-11 PRINTING)

Outlook provides predefined print styles to help you print e-mail messages, tasks, notes, contacts, and calendars.  The Memo print style is used to print individual items, while the other styles print lists - or views - of multiple items and calendars.  When printing an individual item, you can change the page setup with regard to format, paper, and headers and footers.  The format settings allow you to change the font type and letter size for headings.  The fields' font type and size settings affect the text just below the headings and include the subject, sender, and recipient of the mail.  You can choose to print Outlook items using gray shading, which adds shading to titles and graphics.  But it is a good idea to turn off this feature when printing faxes because it decreases the clarity of the text.  The paper settings that you can change affect the paper's type, size, orientation, and source at the printer.  You can also change the top, bottom, right, and left margins for the paper.  Settings for the paper size, source, and orientation may also be changed in the Printer's setup.The Printer Setup dialog box also allows you to change other Windows settings, such as graphics resolution.  The page header prints at the top of each page, while the page footer prints at the bottom of each page.  Both the header and the footer settings are divided into three sections that provide for left-aligned, centered, and right-aligned text.  You can select the font type and letter size for the header and the footer by clicking the relevant Font button.  Five buttons below the footer section provide commonly used text in headers and footers.  The buttons insert the following text:

• page number

• number of pages

• date

• time

• user name

By selecting the Reverse on even pages setting, you can print booklets that have mirrored settings for odd and even pages.  You can preview how the item will print before you actually send it to the printer.  When you print an item or items, you can choose to start each item on a new page.  And you can choose to print attachments to the item as well.  You can also specify page ranges to print, the number of copies to print, and whether or not to collate copies.  When you select the Collate copies checkbox and you have selected to print more than one copy of the item or items, Outlook prints all the pages of one copy before it starts printing the next copy.
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Suppose you want to print an e-mail message with its attached Word document so that you can read it at home.  You want to change the page setup to print the date in the bottom left-hand corner of the page and you want to preview the message before you send it to the printer.  To change the page setup, you highlight the e-mail message and you select File - Page Setup.  Then you select Memo Style to change the page setup for an individual item.  Outlook then opens the Page Setup dialog box.  To add the date to the printed copy, you click the Header/Footer tab.  And to place the date in the bottom left-hand corner, you place the insertion point in the left-hand text box of the Footer section.  To insert the date, you click the Date button.  Outlook then inserts the code for the date in the text box.  You want to see a preview of the printed output before you send it to the printer so you click Print Preview.  You can now see how the result will look on paper.  To open the Print dialog box, you click the Print button.  And to print the attached Word document along with the e-mail message, you select the Print attached files with item(s) checkbox and you click OK.  Outlook prints the e-mail message and it automatically opens Word to print the attached document from there.
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Outlook provides five styles for printing calendars:

• daily

• weekly

• monthly

• tri-fold

• calendar details

Each style has specific options in the Page Setup dialog box in addition to the ordinary options that are available for all styles.  The daily style allows you to print either one or two days per page.  And you can include or exclude the TaskPad and a notes area.  You can also specify a time range to be printed for each day by setting a start time and an end time.  You can set the weekly style to print days from top to bottom or from left to right.  And you can choose to print one week or two weeks per page.  The TaskPad and notes area can be included by selecting their checkboxes.  If you select the Left to right option in the weekly print style, Outlook prints a row on the page for each hour of the day.  You can specify the time parameters for each day, for example, it starts at 7:00am and ends at 7:00pm.  And you can include or exclude weekends from the printed calendar.  For the monthly style you can specify to print one or two months per page.  And you can include the TaskPad and notes area if you wish.  You can choose not to print weekends and to print exactly one month per page.  The Print Exactly One Month Per Page option is provided because some months have more days than others.  The trifold style enables you to create a customized calendar with three sections per page.  For each section you can choose to print a daily, monthly, or weekly calendar.  Or you can choose to print the TaskPad or the notes area.  Using the Calendar Details style you can print a calendar with tasks, notes, and appointments entered at their relevant dates, including the body of the items.  For this style you can select to start a new page each day, week, or month.  And you can choose to print files that are attached to entries in the calendar at the same time as printing the calendar.  In addition to the normal settings for printing items from Outlook, you can specify a start date and end date for a calendar.  And you can choose not to print details of personal items marked as private.
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Suppose you want to use Outlook to print a monthly calendar that you can hang on your office wall for the year 2000.  You want to remove weekends and private appointments from the calendar but you want to include the TaskPad.  And you want to print the calendar on letter-sized paper with a landscape orientation.  You start by selecting File - Page Setup - Monthly Style.  In the Page Setup dialog box you select the TaskPad checkbox to include the TaskPad on the calendar.  And you select the Don't Print Weekends checkbox to exclude weekends from the printed calendar.  To change the orientation of the page, you open the Paper tabbed page.  And you select the Landscape radio button.  Then you click Print.  Outlook opens the Print dialog box where you can set the print start date and end date.  You click the Start down pointing arrow to specify a start date.  Then you click the left-pointing arrow to display January.  And you click Saturday the first to insert the date into the text box.  You follow a similar procedure to enter Sunday, December 31, 2000 in the End text box.  You can also type the dates in the text boxes.  To exclude your personal appointments from the calendar, you select the Hide details of private appointments checkbox.  To start printing, you click OK.  Outlook then proceeds to print your calendar.

END OF ORGANIZING AND PRINTING

SUMMARY: You have seen how to organize and print items and views in Outlook.  

Outlook contains a number of categories by which you can sort, view, and organize information in all views. The predefined categories are contained in a master category list. You can modify this list by deleting or adding categories.  You can assign categories to items when you create them or at a later stage in one of the Outlook views. You can organize the views by sorting items in the views according to the categories which are assigned to them. You can also sort the information in the views for printing or merging using the categories assigned to the items in the view.  Outlook's journal is an electronic log book of all your activities. You can use it to track computer-related activities, such as e-mail, and noncomputer related activities, such as conversations. The journal consists of entries and each entry has at least a subject, an entry type, and a duration. You can also make notes and link the entry to objects such as Word documents or Excel spreadsheets.  Outlook can create journal entries automatically if you configure it to do so. Or you can create entries yourself. You can modify, move, and delete existing entries.  Outlook provides predefined print styles to help you print e-mail messages, tasks, notes, contacts, and calendars. The Memo print style is used to print individual items, while the other styles print lists - or views - of multiple items and calendars. When printing an individual item, you can change the page setup with regard to format, paper, and headers and footers.  You can preview how the item will print before you actually send it to the printer.  Outlook provides five styles especially for printing calendars - daily, weekly, monthly, trifold, and calendar details. Each style has specific options in the Page Setup dialog box, apart from the ordinary options that are available for all styles.

UNIT TEST:

1. Which of the following statements are true of the Master Category List?

a. You can adjust the Master Category List in any Outlook view

b. If you add an item to the Master Category List, it is automatically added to the Available categories list in the current view

c. If you delete an item from the Master Category List, it is automatically deleted from the Available categories list in the current view

d. If you add categories to the current view, they are automatically added to the Master Category List

2. Which of the following statements apply when you are assigning categories to items?

a. You can assign a category to an item only when you are creating the item

b. You can group items in a view according to the categories to which they are assigned

c. You can rearragne items within a category group according to the fields in a view

d. You can assign more than one category to an item

3. Suppose you want to keep a record of the time that you spend on a database that you are creating in Access for your manager.  Which of the following should you do to best accomplish this in Outlook?

a. Configure Outlook to automatically creat a journal entry for Access databases

b. Create a task every time that you intend to work on the database and record the time spent in there

c. Create a note every time that you intend to work on the database and record the time spent in there

d. Schedule a meeting in Outlook's calendar each time that you have worked on the database

4. Is it possible to automatically create journal entries for events that are not computerized, such as telephone conversations?

a. Yes

b. No

5. In which of the following ways can you create a journal entry for the time that you spend creating documents in Word?

a. By attaching the relevant Word documents to e-mail messages

b. By entering all the information yourself

c. By configuring Outlook to automatically create new journal entries when you open Word

d. By configuring Word to automatically create new journal entries in Outlook

6. Which of the following items must you specify in order to configure Outlook to automatically create journal entries for e-mail messages?

a. The IP address or DNS name of your mail server

b. The e-mail addresses of the people who send you mail

c. The e-mail messages activity

d. The contact or contacts that send or receive the e-mail

7. The _____ print style is used to print individual items, while the other styles print lists - or views - of multiple items and calendars.

a. Memo

b. Daily

c. Table

d. Calendar Details

8. Suppose you want to print a calendar that has a weekly calendar, a monthly calendar, and a notes section on one page.  Which print style should you use?

a. Weekly

b. Monthly

c. Calendar details

d. Trifold

9. Which of the following can you change when printing items from Outlook?

a. Font styles

b. Font colors

c. Letter sizes

d. Paper size

e. Printer type

ANSWERS:

1. a, b & d***(ac)

2. b, c & d

3. a

4. Yes

5. b & c***(d)

6. c & d***(b)

7. a***(b)

8. d

9. a, c, d & e***(ab)  END OF BEGINNING OUTLOOK

